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Chapter 1

SARS-CoV-2 Panel Product Information

1.1  Intended use

The SARS-CoV-2 Panel, for use on the MassARRAY® System, is a multiplex RT-PCR/
MALDI-TOF test intended for the qualitative detection of nucleic acid from SARS-CoV-2 in 
upper respiratory samples (nasopharyngeal swab, oropharyngeal swab) and 
bronchoalveolar lavage (BAL) samples from individuals suspected of COVID-19 by their 
healthcare provider. The SARS-CoV-2 Panel is pending FDA review, and is for use in US 
laboratories certified under the Clinical Laboratory Improvement Amendments of 1988 
(CLIA), 42 U.S.C. §263a, to perform high complexity tests. 

Results are for the identification of SARS-CoV-2 RNA. SARS-CoV-2 RNA is generally 
detectable in upper respiratory and bronchoalveolar lavage (BAL) samples during the 
acute phase of infection. Positive results are indicative of the presence of SARS-CoV-2 
RNA; clinical correlation with patient history and other diagnostic information is necessary 
to determine patient infection status. Positive results do not rule out bacterial infection or 
co-infection with other viruses. The agent detected may not be the definite cause of 
disease. Laboratories within the United States and its territories are required to report all 
positive results to the appropriate public health authorities. 

Negative results do not preclude SARS-CoV-2 infection and should not be used as the 
sole basis for patient management decisions. Negative results must be combined with 
clinical observations, patient history, and epidemiological information. 

The SARS-CoV-2 Panel is intended for use by trained clinical laboratory personnel 
specifically instructed and trained in the techniques of reverse transcriptase-PCR and in 
vitro diagnostic procedures. The SARS-CoV-2 Panel is pending FDA review.

1.2  Product description

The panel consists of 5 assays targeting the genome of SARS-CoV-2: three probe the viral 
nucleocapsid (N) gene and two probe ORF1 and ORF1ab. The panel also contains an MS2 
phage assay that monitors RNA extraction. 

Table 1.1   SARS-CoV-2 Panel Panel Content
Assay Name Region

SC2-N1 Nucleocapsid

SC2-N2 Nucleocapsid

SC2-N3 Nucleocapsid

SC2-ORF1 ORF1

SC2-ORF1ab ORF1ab

MS2 Phage -
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1.3  Materials provided

The following items (Table 1.2) are provided in the SARS-CoV-2 Panel Kit. Upon receipt, 
store the items as described. The SARS-CoV-2 Panel comes in six different formats (Table 
1.3).

Table 1.2   SARS-CoV-2 Panel Kit Contents

Table 1.3   SARS-CoV-2 Panel Kits

Materials Provided
Shipping 
Condition

Storage 
Temperature

Storage 
Location 

(see Table 3.1)

SARS-CoV-2 Panel
• SARS-CoV-2 Panel PCR Primers
• SARS-CoV-2 Panel Extend Primers
• UNG (heat labile)
• MMLV Enzyme
• RNase Inhibitor
• MS2 Control

Dry Ice -25°C to - 10°C Lab Area 2

PCR Reagent Set with dUTP
• MgCl2, 25 mM
• 10X PCR Buffer
• dUTP/dNTP Mix
• PCR Enzyme

Dry Ice -25°C to - 10°C Lab Area 2

iPLEX® Pro Reagent Set
• 3-Point Calibrant
• iPLEX Termination Mix
• iPLEX Buffer Plus, GPR
• iPLEX Pro Enzyme
• SAP Buffer
• Shrimp Alkaline Phosphatase (SAP)

Dry Ice -25°C to - 10°C Lab Area 2

SpectroCHIP Arrays Ambient 
Temperature 15°C to 25°C Lab Area 3

Part # Number of tests Type of SpectroCHIP Array

13279 960 tests SpectroCHIP-96, 10 x 96

13279F 960 tests SpectroCHIP CPM-96, 10 x 96

13278 768 tests SpectroCHIP-384, 2 x 384

13278D 768 tests SpectroCHIP CPM-384, 2 x 384

13281 3840 tests SpectroCHIP-384, 10 x 384

13281D 3840 tests SpectroCHIP CPM-384, 10 x 384
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1.4  Materials required but not provided

“MLS” indicates that the item is available from major laboratory suppliers.

Table 1.4   Materials Required but not Provided
Item Source/Specification

Instruments and Equipment

MassARRAY System with:
• Typer software v5.0.1 or greater
• RT-Workstation v4.1 or greater
• Chip Prep Controller v2.2 or greater (if using 

Chip Prep Module)

Agena Bioscience
• MassARRAY System with Chip Prep Module 

(CPM) 96
• MassARRAY System with Chip Prep Module 

(CPM) 384
• MassARRAY Analyzer 4 and Nanodispenser 

RS1000 96
• MassARRAY Analyzer 4 and Nanodispenser 

RS1000 384

Plate centrifuge MLS; Max. RCF with plate rotor: 3,486 x g

Vortex MLS; Variable speed, suitable for tubes and 
plates

Mini tube centrifuge MLS; Recommend additional rotor option for 2 x 
8-tube PCR strips

Refrigerated tube centrifuge MLS; Capacity up to 12,000 ng

Thermocycler MLS; With appropriate plate block; max ramp rate 
4°C/second

PCR workstation with UV irradiation MLS; UV light with timer; dual UV bulb preferred

Additional Software

SC2 Report v1.0 or greater Agena’s customer support portal

RNA Extraction Materials

TRI reagent MLS; phenol and guanidine thiocyanate in a 
monophase solution

Chloroform MLS; HPLC-grade

GlycoblueTM coprecipitant ThermoFisher, #AM9515

Ethanol MLS; Absolute (200 proof), molecular biology 
grade

Nuclease-free water MLS; molecular biology grade

Isopropanol, molecular biology grade Sigma Aldrich (#I9516) or equivalent

Additional Reagents

Positive SARS-CoV-2 RNA Control Twist Bioscience Synthetic SARS-CoV-2 RNA 
Control 1 (#102019)

HPLC-grade water MLS; Residue after evaporation ≤2ppm; Sterile, 
nuclease- and DEPC-free; >18.2 MΩ

DNA AWAYTM MLS

Type 1 water or deionized water MLS; NCCLS, CAP or ATSM; >18.2 MΩ

Clean Resin Agena Bioscience, #08060 [40g], #08040 [28g]
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Labware

Electronic multichannel pipettes and filtered tips 
(Optional; can use manual multichannel pipettes)

MLS; 8- or 12-channel electronic adjustable tip 
spacing pipette; 0.5 µL -12.5 µL

Manual multichannel pipettes and filtered tips MLS; 8- or 12-channel pipette
0.5 µL -20 µL
20 µL - 200 µL

Single channel pipettes and filtered tips MLS; 0.1 µL - 2 µL
0.5 µL -10 µL
10 µL -100 µL
100 µL -1000 µL

Microtubes MLS; RNase-, DNase-, human DNA-, and PCR 
inhibitor-free

Volume: 1.5 mL, 5 mL

PCR strip tubes (optional) MLS; 8- or 12-well strips with caps; volume: 0.2 
mL

Tube racks MLS

Sealing roller tool and paddle MLS

Disposable pipetting reservoirs MLS; DNase- and RNase-free; volume: 25 mL and 
50 mL; sterile

Clear adhesive plate seals MLS; Strong adhesive, -20ºC to 120 ºC

MassARRAY System with Chip Prep Module 96

96-well semi-skirted, colored microtiter plates

OR

96-well non-skirted microtiter plates

ThermoFisher MicroAmp® EnduraPlateTM 
#4483343 or equivalent.; Working vol.: 0.2 mL; 
Max well volume: 0.25 mL

Thermo ScientificTM PCR Plate #AB0600L or 
equivalent; Working volume: 0.2 mL; Max fill 
volume: 0.3 mL

Isopropanol MLS

MassARRAY System with Chip Prep Module 384

384-well microtiter plates Thermo ScientificTM 384-Well Full Skirted PCR 
Plate #TF-0384 or equivalent; Full skirted: 
Working volume: 25 µL, Max volume: 40 µL 

Isopropanol MLS

MassARRAY Analyzer 4 and Nanodispenser RS1000 System (96 format)

96-well non-skirted microtiter plates Thermo ScientificTM PCR Plate #AB0600L or 
equivalent; Working volume: 0.2 mL; Max fill 
volume: 0.3 mL

96-well fully skirted MTP plate base Agena Bioscience #179108 

Resin dimple plate and scraper Supplied with Agena Bioscience MassARRAY 
System with RS1000 Nanodispenser

Plate/tube rotator MLS; 360º rotation, with standard rotisserie

NaOH MLS; 0.1 M

Ethanol MLS; Absolute (200 proof); molecular biology 
grade

Item Source/Specification
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1.5  Workflow

After sample collection, RNA extraction is performed using a TRI-based method. RT-PCR 
with iPLEX® Pro chemistry then amplifies target regions of interest. After the inactivation 
of unincorporated dNTPs, a sequence-specific primer extension step is performed using 
the supplied Extend primers and iPLEX Pro reagents. 

The extension products (analyte) are desalted, transferred to a SpectroCHIP® Array (a 
silicon chip with pre-spotted matrix crystal) and then loaded into the MassARRAY 
Analyzer (a MALDI-TOF mass spectrometer). The analyte/matrix co-crystals are irradiated 
by a laser, inducing their desorption and ionization. The positively charged molecules 
accelerate into a flight tube towards a detector. Separation occurs by time-of-flight, which 
is proportional to the mass of the individual molecules. After data processing, a spectrum 
is produced with relative intensity on the y-axis and mass/charge on the x-axis. Data 
acquired by the MassARRAY Analyzer is processed by MassARRAY Typer software, and 
then the SC2 Report software.

Table 1.5   Workflow

MassARRAY Analyzer 4 and Nanodispenser RS1000 System (384 format)

384-well microtiter plates Thermo ScientificTM 384-Well Full Skirted PCR 
Plate #TF-0384 or equivalent; Full skirted: 
Working volume: 25 µL, Max volume: 40 µL 

Resin dimple plate and scraper Supplied with Agena Bioscience MassARRAY 
System with RS1000 Nanodispenser

Plate/tube rotator MLS; 360º rotation, with standard rotisserie

NaOH MLS; 0.1 M

Ethanol MLS; Absolute (200 proof); molecular biology 
grade

Item Source/Specification

Step See...

1. Software Setup Chapter 2

• Import the assay design file.
Only required before the first time you run the panel.

• Create a virtual plate.

2. Assay Protocol Chapter 3

RNA extraction

RT-PCR amplification

SAP reaction

iPLEX Pro extension reaction

Water addition

3. Data Acquisition on the MassARRAY System

MassARRAY System with CPM 96 Chapter 4

MassARRAY System with CPM 384 Chapter 5

MassARRAY Analyzer 4 and Nanodispenser RS1000 Chapter 6

4. Generate Results Reports Chapter 7
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1.6  Samples and controls

Patient samples must be collected according to appropriate clinical guidelines. Positive 
and negative test controls must be included to accurately interpret patient test results.

Include the following controls on each plate:

Table 1.6   Controls

1.7  Warnings and precautions

•   For In Vitro Diagnostic Use pending FDA review.

•   For prescription use only.

•   Care must be taken to avoid mislabeling/misidentifying samples.

•   Reduced sample input can adversely affect ability to detect SARS-CoV-2 virus.

•   Do not eat, drink, smoke, or apply cosmetic products in the work areas.

•   Positive results are indicative of SARS-CoV-2 RNA.

•   Laboratories within the United States and its territories are required to report all 
positive results to the appropriate public health authorities.

•   Always use pipette tips with aerosol barriers. Tips that are used must be sterile and 
free of DNases and RNases. 

•   Samples and controls should always be treated as if infectious and/or biohazardous 
in accordance with safe laboratory procedures.

•   Follow necessary precautions when handling samples. Use personal protective 
equipment (PPE) consistent with current guidelines for the handling of potentially 
infectious samples.

•   Dispose of waste in compliance with local, state, and federal regulations.

•   All human-sourced materials should be considered potentially infectious and 
should be handled with universal precautions. If spillage occurs, immediately 
disinfect with a freshly prepared solution of 0.5% sodium hypochlorite in distilled or 
deionized water (dilute household bleach 1:10) or follow appropriate site 
procedures.

•   Fresh clean gloves must be worn in each area and must be changed before leaving 
that area.

•   Do not pipette by mouth.

•   Working with TRI reagent requires personal protective equipment (PPE) and a 
chemical fume hood with adequate ventilation.

Control Used to Monitor Assays

Positive Control 

(Twist Bioscience Synthetic 
SARS-CoV-2 RNA Control 1 
#102019)

RT-PCR reaction set up and 
reagent integrity All five SARS-CoV-2 assays

Negative Control Contamination during RNA 
extraction and reaction setup

All five SARS-CoV-2 assays

MS2 assay

MS2 Control RNA extraction MS2 assay
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•   Prolonged exposure to phenol fumes or contact with skin can be hazardous and 
emergency medical attention should be initiated.

•   Safety Data Sheets (SDS) are available on the Agena customer support portal, or by 
contacting Customer Support.

•   Modifications to assay reagents, assay protocol, or instrumentation are not 
permitted.

•   Do not use the kit or any kit components past the expiration date indicated on the 
kit carton label.

•   In the event of damage to the protective packaging, consult the Safety Data Sheet 
(SDS) for instructions.

•   Reagents must be stored as specified in Table 1.2 or by their manufacturer.

•   Ensure all equipment utilized is calibrated and maintained according to 
manufacturer instructions.

1.8  Limitations

•   The SARS-CoV-2 Panel is pending FDA review, and is for use in US laboratories 
certified under the Clinical Laboratory Improvement Amendments of 1988 (CLIA), 
42 U.S.C. §263a, to perform high complexity tests.

•   This device may not be able to differentiate newly emerging SARS-CoV-2 subtypes.

•   Analyte targets (viral sequences) may persist in vivo, independent of virus viability. 
Detection of analyte target(s) does not imply that the corresponding virus(es) are 
infectious or are the causative agents for clinical symptoms.

•   All results from this and other tests must be considered in conjunction with the 
clinical history, epidemiological data, and other data available to the clinician 
evaluating the patient.

•   Samples must be collected, transported, and stored using appropriate procedures 
and conditions. Improper collection, transport, or storage of samples may hinder 
the ability of the assay to detect the target sequences.

•   The performance of the SARS-CoV-2 Panel was established using nasopharyngeal 
swabs (NP) and bronchoalveolar lavage (BAL) samples. Oropharyngeal swabs are 
also considered acceptable sample types for use with the SARS-CoV-2 Panel, but 
performance has not been established. 

•   Extraction and amplification of nucleic acid from clinical samples must be 
performed according to the specified methods listed in this procedure. Other 
extraction approaches and processing systems have not been evaluated.

•   This test is a qualitative test and does not provide the quantitative value of 
detected organisms present.

•   There is a risk of false positive values resulting from:

• Cross-contamination by target organisms, their nucleic acids or amplified 
product, or from non-specific signals in the assay.

• Cross-contamination during sample handling or preparation. 

• Cross-contamination between patient samples. 
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• Sample mix up. 

• RNA contamination during product handling. 

•   There is a risk of false negative values due to:

• The presence of sequence variants in the pathogen targets of the assay, 
procedural errors, amplification inhibitors in samples, or inadequate numbers 
of organisms for amplification. 

• Improper sample collection.

• Sample mix up.

• Degradation of the SARS-CoV-2 RNA during shipping/storage.

• Sample collection does not collect SARS-CoV-2 RNA.

• Using unauthorized extraction or assay reagents. 

• The presence of RT-PCR inhibitors.

• Mutation in the SARS-CoV-2 virus.

• Failure to follow instructions for use.

•   The impacts of vaccines, antiviral therapeutics, antibiotics, chemotherapeutic or 
immunosuppressant drugs have not been evaluated. 

•   This test cannot rule out infections caused by other viral or bacterial pathogens not 
present on this panel.

•   Negative results do not preclude infection with SARS-CoV-2 virus, and should not 
be the sole basis of a patient management decision. 

•   This device has been evaluated for use with human sample material only.

•   The performance of this device has not been evaluated for patients without signs 
and symptoms of infection.

•   The performance of this device has not been evaluated for monitoring treatment of 
infection.

1.9  Symbols

Table 1.7   Symbols

Catalog number Temperature limits

Batch code Manufacturer

Use-by date For in vitro diagnostic use

Quantity Contains sufficient for <n> 
tests
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Chapter 2

Software Setup

2.1  Import the assay design file

Note: The assay design file only needs to be imported once, prior to running the panel for 
the first time.

1. Locate the SC2 assay design file (SC2_ADF.tsv), at C/MassARRAY/Typer/bin/Reports/
SC2 Report.

2. Open MassARRAY Typer Assay Editor.

3. Create a new assay project in the Database Browser by right clicking the root node 
and selecting Project Administrator.

4. Add a new Assay Project with an appropriate name. The new Assay Project will 
appear in the database browser. The SC2 assay design file will be stored in this 
project.

5. Right-click on the newly created Assay Project and select Import Assay Group in 
Designer format...

6. Remove the checkmarks next to Design Summary and SNP Group. Make sure that 
there is a checkmark next to Assay Group.

7. Click the Browse button next to Assay Group. In the Open window, select All Files in 
the Files of type: field.

8. Navigate to the folder containing the SC2 assay design file (SC2_ADF.tsv), select it, 
and click Open.

9. Click the Import button to import the file.

2.2  Create a virtual plate

Note: Plate names and sample names should all be unique.

Create a sample group Note: Each plate contains one positive control sample and one negative control sample. 
In order for the software to recognize the controls, “PC” must be the prefix for positive 
control samples, and “NC” must be the prefix for negative control samples (e.g., PC_1, 
NC_1).

1. Create a text file (.txt) of sample descriptions in a spreadsheet application such as 
Microsoft® Excel. The file must contain the sample ID in column A, and may contain a 
description in column B.

2. Create a sample customer and sample project in the database, if you have not already 
done so.

a. Open the MassARRAY Typer Plate Editor software and click on the Sample tab.

b. To create a sample customer, right-click the root-node and select Add New 
Sample Customer. Enter a sample customer ID and additional optional 
information and click OK. The new sample customer will appear in the Sample tab.

c. To create a sample project, right-click the sample customer that the sample 
project will be under and select Add New Sample Project. Enter a sample project 
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ID and optional additional information and click OK. The new sample project will 
appear in the Sample tab.

3. Create a sample group.

a. Right-click on the sample project that you want to add the sample group to and 
select Add New Sample Group. 

b. Enter a sample group ID and click the folder button in the toolbar to browse to the 
location of your sample group text file, and click Open, then click OK.

Create a Plate 1. Create a customer and project in the database, if you have not already done so.

a. In the MassARRAY Typer Plate Editor software click on the Plate tab.

b. To create a customer, right-click the root-node and select New Customer. Enter 
a customer ID and additional optional information and click OK. The new customer 
will appear in the Plate tab.

c. To create a project, right-click the customer that the project will be under and 
select New Project. Enter a project ID and optional additional information and 
click OK. The new project will appear in the Plate tab.

2. Create a plate.

a. Right-click on the project that you want to add the plate to and select New Plate.

b. Enter a unique plate ID and select the plate type (96- or 384-well) and click OK. 
The new plate will appear in the Plate tab and a plate layout will be created 
automatically, based on the plate type specified.

Apply Assays to the 
Plate

1. In the Plate tab, select the plate that was just created. 

2. Select the Assay tab and locate the SC2 assay design file you imported earlier 
(SC2_ADF.tsv).

3. In the plate layout, select the wells of interest.

4. In the Assay tab, right-click the plex or assay that you want to assign to the selected 
wells and select Add plex or Add assay.

Apply Samples to the 
Plate

1. Click on the Sample tab.

2. In the plate layout, select the wells of interest.

3. Right-click the sample or sample group that you want to assign to the selected wells 
and select Apply Samples from Group or Add Sample.

4. Select File > Save from the toolbar.
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Chapter 3

Assay Protocol

3.1  Lab areas and plate layout

The laboratory space should include three separate (non-contiguous) work areas to 
prevent contamination of PCR products. Table 3.1 shows the activities that are conducted 
in each area.

Table 3.1   Lab Area Activities

Include one positive control and one negative control on each plate.

3.2  RNA extraction

IMPORTANT!
Perform this procedure in Lab Area 1.

WARNING!
Be careful not to disturb the RNA pellet when discarding supernatant.

Preparation before 
each extraction

1. Thaw MS2 Control and samples on ice.

2. Vortex the tubes containing the sample at maximum speed for 1 minute.

3. Use 300 μL as the input sample in Step 3 below.

RNA Extraction 1. Determine the number of required reactions based on the number of patient samples 
to be processed, plus one negative control per extraction set.

2. Prepare fresh 75% ethanol solution using 100% absolute ethanol and nuclease-free 
water, sufficient for 1 mL per reaction, plus 10% overage.

3. Place 300 μL of sample in universal transport medium (or of nuclease-free water, for 
the negative control) into a new 1.5 mL tube.

4. Add 800 μL ice-cold TRI reagent and mix by pipetting and vortexing.

Lab Area Activities

1 Isolation and preparation of RNA.

2
Pre-PCR preparation, including preparation of the RT-PCR cocktail, 
addition of the RT-PCR cocktail and RNA to the reaction plate, and 
preparation of the SAP and extension cocktails.

3

Positive control sample preparation. Thermocycling the reaction 
plate after addition of RT-PCR cocktail and RNA; addition of the SAP 
cocktail to the reaction plate and thermocycling; addition of the 
extension reaction cocktail to the reaction plate and thermocycling; 
desalting; nanodispensing; and data acquisition.
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5. Add 10 μL of MS2 Control.

6. Incubate for 5 minutes at room temperature (20-25°C).

7. Add 200 μL chloroform and mix by vigorous shaking for 15 seconds.

8. Incubate for 5 minutes at room temperature (20-25°C).

9. Centrifuge for 15 minutes at 10,000 x g at 4°C.

10. Transfer the top aqueous layer (up to 600 μL) to a new tube using pipettor.

WARNING!
Be careful not to transfer any of the other layers; instead, leave some of the top layer behind.

11. Add 2 μL of Glycoblue to tube and mix by pipetting.

12. Add 600 μL of ice-cold isopropanol (molecular biology grade) and invert 5 times to 
mix. 

13. Incubate for 30 minutes at -20°C.

14. Centrifuge for 5 minutes at 10,000 x g at 4°C.

15. Visually check for the presence of the RNA pellet. If the pellet is not visualized, 
perform the following steps:

a. Add 2 μL of Glycoblue to tube and mix by pipetting.

b. Incubate for 10 minutes at -20°C.

c. Centrifuge for 5 minutes at 10,000 x g at 4°C.

16. Discard supernatant using a pipettor.

17. Add 1 mL of ice-cold 75% ethanol and mix by gently tapping the tube.

18. Centrifuge for 5 minutes at 7,500 x g at 4°C.

19. Discard supernatant using a pipettor.

20. Centrifuge for 1 minute at 7,500 x g at 4°C.

21. Discard supernatant using a pipettor (P10 or P100/200). 

22. Airdry for 10 minutes at room temperature (20-25°C). 

WARNING!
Insufficient evaporation of ethanol can cause inhibition of PCR.

23. Resuspend in 10 μL of nuclease-free water and incubate at 37°C for 10 minutes.

STOPPING POINT
Use RNA right away or store in sealed container at -80°C until needed.



Chapter 3  Assay Protocol 15

IFU-CUS-001 R02SARS-CoV-2 Panel Instructions for Use
Pending FDA Review

3.3  Positive control sample preparation

IMPORTANT!
Prepare the positive control sample in Lab Area 3.

Prepare the positive control by diluting the Twist Bioscience Synthetic SARS-CoV-2 RNA 
Control 1 (1x106 copies/µL) to a working stock of 16.7 copies/µL, as shown in Table 3.2. 
Make multiple aliquots at once and store at -80°C.

WARNING!
Exercise caution when performing the serial dilutions. Risk of lab contamination is high due to the 
highly concentrated RNA control being used.

1. Prepare a 100-fold dilution by pipetting 990 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of SARS-CoV-2 RNA Control. Mix well, then centrifuge briefly.

2. Prepare a 10-fold dilution by pipetting 90 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of the step 1 dilution. Mix well, then centrifuge briefly.

3. Prepare a 10-fold dilution by pipetting 90 µL of nuclease-free water into a microfuge 
tube, then adding 10 µL of step 2 dilution. Mix well, then centrifuge briefly.

4. Pipette 83.3 µL of nuclease-free water into a microfuge tube, then add 16.7 µL of step 
3 dilution. Mix well, then centrifuge briefly.

Table 3.2   Positive Sample Control Dilution

Label with correct copies/µL and store each dilution in aliquots at -80°C. When needed to 
make new positive controls, take one of the tubes and dilute as per table above, from the 
specific copy number down.

3.4  RT-PCR amplification

IMPORTANT!
Prepare the RT-PCR cocktail and add cocktail and samples to the reaction plate in Lab Area 2. 
Thermocycle the RT-PCR reaction plate in Lab Area 3. Maintain an RNase-free environment and 
keep samples on ice during use. Make sure all reagents are thawed completely at room 
temperature and enzymes are kept on ice. Make sure reagents are homogenized before taking 
aliquots. If plates were stored frozen prior to this step, make sure they are thawed completely, 
gently homogenized, spun down, and kept on ice.

1. Turn on the PCR thermal cycler with the program shown in Table 3.5, so that the heated 
cover can come to the correct operating temperature and there is no time delay 
between the RT-PCR reaction plate being prepared and cycling being started.

Dilutions

Step
Final 

concentration 
(copies/μL)

Amount of 
SARS-CoV-2 
RNA Control 

transferred (μL)

Source Nuclease-
free water

Final 
Volume (μL)

1 10,000 10 Stock 990 1,000

2 1,000 10 Step 1 90 100

3 100 10 Step 2 90 100

4 16.7 16.7 Step 3 83.3 100
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2. Prepare the RT-PCR cocktail in a 1.5 mL tube placed on ice or a cold block by adding 
reagents in the order in which they are listed in Table 3.3. 
Prepare more cocktail than the number of RT-PCR reactions to be performed. Either 
prepare for one or more extra reactions or use a percentage extra to ensure sufficient 
overage is present to overcome typical pipetting variation.

Table 3.3   RT-PCR Reaction

3. Pulse vortex the tube briefly 3 times and briefly centrifuge.

4. Dispense 2.0 μL RT-PCR cocktail into each well of a new microtiter plate. 

5. Add 3.0 μL of either sample RNA, positive control, or negative control to each well of 
the plate.

Table 3.4   Samples and Controls

6. Seal the RT-PCR reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 
x g for 15 seconds.

7. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate cocktail solution is present in every well before continuing.

Reagent Per Reaction (μL)

10X PCR Buffer 0.500

MgCl2, 25 mM 0.400

dUTP/dNTP Mix 0.100

UNG (heat labile) 0.050

RNase Inhibitor 0.125

PCR Enzyme 0.200

MMLV Enzyme 0.125

SARS-CoV-2 PCR Primer 0.500

RT-PCR Cocktail Final Volume 2.000

Sample RNA/Positive Control/
Negative Control

3.000

RT-PCR Reaction Final Volume 5.000

Component

Volume per reaction

Sample 
reaction

Positive 
control 

reaction

Negative 
control 

reaction

RT-PCR Cocktail 2.0 μL 2.0 μL 2.0 μL

Purified sample RNA 
(from RNA Extraction section 
above)

3.0 μL -- --

Positive control 
(from Positive Control Preparation 
section above)

-- 3.0 μL --

Purified negative control (from 
RNA Extraction section above) -- -- 3.0 μL

Total volume 5.0 μL 5.0 μL 5.0 μL
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8. Thermocycle the RT-PCR reaction plate using the conditions in Table 3.5. On a 
standard cycler with a ramp rate of approximately 3-4°C/s this program takes 
approximately 2 hours and 45 minutes.

Table 3.5   RT-PCR Thermal Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.5  SAP reaction

IMPORTANT!
Prepare the SAP cocktail in Lab Area 2. Add the SAP cocktail to the RT-PCR reaction plate and 
thermocycle the plate in Lab Area 3. Make sure all reagents are thawed completely and enzymes 
are kept on ice. Make sure all reagents are homogenized before taking aliquots. If plates were 
stored frozen prior to this step, make sure they are thawed completely, gently homogenized, spun 
down, and kept on ice.

1. Prepare the SAP cocktail in a 1.5 mL tube on ice or a cold block as shown in Table 3.6. 
Prepare more cocktail than the number of SAP reactions to be performed. Either 
prepare for one or more extra reactions or use a percentage extra to ensure sufficient 
overage is present to overcome typical pipetting variation.

Table 3.6   SAP Cocktail

2. Pulse vortex the tube briefly 3 times and briefly centrifuge.

3. Centrifuge the RT-PCR reaction plate at 1000 x g for 15 seconds.

4. Dispense 2 μL of SAP cocktail into each well of the reaction plate. 

Step Temperature Time Number of Cycles

1 UNG incubation 25°C 5 minutes 1 cycle

2 RNA reverse transcription into cDNA 55°C 30 minutes 1 cycle

3 Polymerase activation 95°C 2 minutes 1 cycle

4

PCR to amplify specific fragments

95°C 30 seconds

45 cycles of steps 4-65 60°C 30 seconds

6 72°C 1 minute

7 Final extension 72°C 5 minutes 1 cycle

8 Sample preservation 10°C -- Hold

Reagent Per reaction (μL)

HPLC-grade water 1.53

SAP Buffer 0.17

Shrimp Alkaline Phosphatase (SAP) 0.30

SAP Cocktail Final Volume 2.00
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5. Seal the reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 x g for 
15 seconds.

6. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate solution is present in every well before continuing.

7. Thermocycle the reaction plate using the conditions in Table 3.7. On a standard cycler 
with a ramp rate of approximately 3-4°C/s this program takes approximately 45-50 
minutes.

Table 3.7   SAP Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.6  iPLEX Pro extension reaction

IMPORTANT!
Prepare the extension reaction cocktail in Lab Area 2. Add the extension reaction cocktail to the 
reaction plate and thermocycle the plate in Lab Area 3. Make sure all reagents are thawed 
completely and enzymes are kept on ice. Make sure all reagents are homogenized before taking 
aliquots. If plates were stored frozen prior to this step, make sure they are thawed completely, 
gently homogenized, spun down, and kept on ice.

1. Prepare the extension cocktail in a 1.5 mL tube on ice or a cold block, as shown in Table 
3.8. Prepare more cocktail than the number of extension reactions to be performed. 
Either prepare for one or more extra reactions per extension or use a percentage extra 
to ensure sufficient overage is present to overcome typical pipetting variation.

Table 3.8   Extension Cocktail

Step Temperature Time Number of Cycles

1 Dephosphorylation 37°C 40 minutes 1 cycle

2 Enzyme inactivation 85°C 5 minutes 1 cycle

3 Sample preservation 10°C -- Hold

Reagent Per reaction (μL)

HPLC-grade water 0.62

iPLEX Buffer Plus, GPR 0.20

iPLEX Termination Mix 0.20

iPLEX Pro Enzyme 0.04

SARS-CoV-2 Extend Primer 0.94

Extension Cocktails Final Volume 2.00
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2. Pulse vortex the tube briefly 3 times and briefly centrifuge.

3. Centrifuge the reaction plate at 1000 x g for 15 seconds.

4. Dispense 2 μL of extension reaction cocktail into each well of the reaction plate. 

5. Seal the reaction plate, briefly pulse vortex 1-2 times, then centrifuge at 1000 x g for 
15 seconds.

6. Visually inspect the individual wells from the bottom of the reaction plate to confirm 
uniform and adequate solution is present in every well before continuing.

7. Thermocycle the reaction plate using the conditions in Table 3.9. On a standard cycler 
with a ramp rate of approximately 3-4°C/s this program takes approximately 2 hours 
and 35 minutes.

Table 3.9   Extension Thermal Cycling Conditions

STOPPING POINT
If not proceeding directly to the next step, the reaction plate should be sealed, and stored at 4°C 
(if storing for less than 24 hours), or at -20°C (if storing for more than 24 hours). Do not store for 
more than 2 weeks.

3.7  Water addition

1. Add HPLC-grade water to each well of the reaction plate.

a. For 96-well plates, add 41 μL.

b. For 384-well plates, add 16 μL.

2. Seal the plate and centrifuge at 1000 x g for 1 minute.

STOPPING POINT
If not proceeding directly to processing the plate on the MassARRAY System, the reaction plate 
should be sealed, and stored at 4°C (if storing for less than 24 hours), or at -20°C (if storing more 
than 24 hours). Do not store for more than 2 weeks.

Step Temperature Time Number of Cycles

1 Initial denaturation 95°C 30 seconds 1 cycle

2 Denaturation 95°C 5 seconds 1 cycle 40 cycles of:
1 cycle of step 2 

followed by 5 cycles 
of steps 3 and 4 
(200 cycles total)

3 Annealing/Extension 52°C 5 seconds
5 cycles4 Denaturation 80°C 5 seconds

5 Final extension 72°C 3 minutes 1 cycle

6 Sample preservation 10°C -- Hold
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3.8  Data acquisition

Follow the data acquisition instructions in the chapter for the MassARRAY System you are 
using.

Table 3.10   Data Acquisition Instructions
System Instructions

MassARRAY System with Chip Prep Module 96 Chapter 4

MassARRAY System with Chip Prep Module 384 Chapter 5

MassARRAY Analyzer 4 and Nanodispenser RS1000,
96- or 384-format Chapter 6
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Chapter 4

Data Acquisition on the MassARRAY System
with Chip Prep Module 96

4.1  Create an input file

1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry. 

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 96 to 96 as the dispenser method. 

8. Enter an experiment name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the 
second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set 
up the automatic run.

4.2  Prepare the instrument

1. Double-click the Start All icon to start MassARRAY Caller, Analyzer Control, Chip Prep 
Controller (CPC), and SpectroACQUIRE.

2. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, 
System Fluid, and Resin buttons; they should be green/Okay. If any are red (Waste 
Tank Full, System Fluid Empty, Resin Low or Empty) perform the necessary 
maintenance. 

3. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The 
deck will extend.

4. If there are SpectroCHIP Arrays in the completed chips position on the deck remove 
them.

5. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been 
refrigerated) or 10 minutes (if it has been frozen). Pipette 75 μL of calibrant into the 
calibrant vial and place in the calibrant vial holder on the deck.

6. Load the SpectroCHIP Arrays.

a. Orient the Chip holder so that the bevelled corner is at the top right.

b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into 
the chip holder in position 1 (on the left); orient the SpectroCHIP Array such that 
the Agena logo and barcode are at the bottom. Make sure that the SpectroCHIP 
Array is properly seated so that the chip holder and SpectroCHIP Array surface 
are flush.
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c. If you are processing two plates, insert another new SpectroCHIP Array into the 
chip holder in position 2 (on the right). If you are only processing one plate, place 
a previously completed SpectroCHIP Array in position 2, as the MassARRAY 
Analyzer requires both SpectroCHIP Array positions to be filled to function 
properly.

d. Place the full chip holder in the chip holder tray, new chips position, on the deck.

7. Load microtiter plates (MTPs). Up to two 96-well microtiter plates of analyte may be 
loaded.

WARNING!
The Chip Prep Module is configured at installation for the particular plates you will be using. If at 
any point you wish to change the plates you are using, contact Agena Bioscience Customer 
Support to update instrument configuration. Using plates with different well depth without 
reconfiguration can damage the instrument or compromise assay performance.

a. Centrifuge the plates at 1000 x g for 1 minute.

b. Place the first MTP on MTP holder 1 (on the left). This corresponds to chip position 
1. Orient the plate such that well A1 is in the front left corner.

c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This 
corresponds to chip position 2.

8. Click Chip prep module Deck In/Out again to retract the deck.

4.3  Set up and start the run

WARNING!
Confirm that instrument settings are correct, as shown in the tables below, prior to each run.

1. Select the Run Setup tab in SpectroACQUIRE.

2. In the Experiment Setup section:

a. Under MTP 1, click on the browse button next to Experiment Name and select the 
XML input file created earlier.

b. In the Wells to Process field, select Automatic.

c. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in 
the Experiment Name and Wells to Process fields for MTP 2.

d. Enter the settings for the SpectroCHIP type being used, as shown in Table 4.1.

Table 4.1   Experiment Setup Settings

3. In the Analyzer Setup section:

a. Select Tools > Load Parameters on the SpectroACQUIRE toolbar, then select the 
appropriate parameter file based on the SpectroCHIP type. Acquisition 
parameters will automatically populate. 

b. Make sure all settings in this section are as shown in Table 4.2.

SpectroCHIP CPM-96 SpectroCHIP-96

Use Autotune Selected Selected

Start Dispense Condition 600 650

Resin Volume 13 13

Sample Volume n/a 10
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Table 4.2   Analyzer Setup Settings

4. In the Chip Prep Module Setup section:

a. Check the Normal Operation box.

b. Check MTP Barcodes Required, if desired.

c. Select iPLEX in the Chemistry drop-down menu.

5. In the Temperature Control section:

a. If the MTP and calibrant will not be removed from the instrument shortly after the 
run is completed, select the MTP Cool box, and check the Auto box. 

b. If using a SpectroCHIP CPM-96, check the Chip Heat box and enter 30 in the 
Setpoint field.

6. If desired, enter your email and check the When Chip prep module is finished and 
When MA4 is finished boxes to receive email notifications.

7. Click Start Chip prep module to start the run.

4.4  Remove plates, calibrant, and SpectroCHIP Arrays when run is complete

1. Once the run is completed, click Chip prep module Deck In/Out to move the deck out 
and remove the MTPs and calibrant vial. Store remaining calibrant refrigerated or frozen 
for future use.

2. Click Remove Old Chips from MA4 in the Run Setup tab. The instrument will move 
the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed 
chips position on the Chip Prep Module deck, and then extend the deck so you may 
remove the SpectroCHIP Arrays from the completed chips position.

SpectroCHIP CPM-96 SpectroCHIP-96

Parameter file name iPLEX_CPM.par iPLEX.par

Shots (n) 30 20

Maximum acquisitions 9 9

Minimum good spectra 5 5

Maximum good spectra 5 5

Turn Off HV After Analysis Selected Selected

Analyze Calibrant Pads Selected Selected

Filter Saturated Shots Selected Selected

Chip Type SpectroCHIP CPM-96 SpectroCHIP-96
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Chapter 5

Data Acquisition on the MassARRAY System
with Chip Prep Module 384

5.1  Create an input file

1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry. 

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 384 to 384 as the dispenser method. 

8. Enter an experiment name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the 
second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set 
up the automatic run.

5.2  Prepare the instrument

1. Double-click the Start All icon to start MassARRAY Caller, Analyzer Control, Chip Prep 
Controller (CPC), and SpectroACQUIRE.

2. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, 
System Fluid, and Resin buttons; they should be green/Okay. If any are red (Waste 
Tank Full, System Fluid Empty, Resin Low or Empty) perform the necessary 
maintenance. 

3. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The 
deck will extend.

4. If there are SpectroCHIP Arrays in the completed chips position on the deck remove 
them.

5. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been 
refrigerated) or 10 minutes (if it has been frozen). Pipette 75 μL of calibrant into the 
calibrant vial and place in the calibrant vial holder on the deck.

6. Load the SpectroCHIP Arrays.

a. Orient the Chip holder so that the bevelled corner is at the top right.

b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into 
the chip holder in position 1 (on the left); orient the SpectroCHIP Array such that 
the Agena logo and barcode are at the bottom. Make sure that the SpectroCHIP 
Array is properly seated so that the chip holder and SpectroCHIP Array surface 
are flush.
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c. If you are processing two plates, insert another new SpectroCHIP Array into the 
chip holder in position 2 (on the right). If you are only processing one plate, place 
a previously completed SpectroCHIP Array in position 2, as the MassARRAY 
Analyzer requires both SpectroCHIP Array positions to be filled to function 
properly.

d. Place the full chip holder in the chip holder tray, new chips position, on the deck.

7. Load microtiter plates (MTPs). Up to two 384-well microtiter plates of analyte may be 
loaded.

WARNING!
The Chip Prep Module is configured at installation for the particular plates you will be using. If at 
any point you wish to change the plates you are using, contact Agena Bioscience Customer 
Support to update instrument configuration. Using plates with different well depth without 
reconfiguration can damage the instrument or compromise assay performance.

a. Centrifuge the plates at 1000 x g for 1 minute.

b. Place the first MTP on MTP holder 1 (on the left). This corresponds to chip position 
1. Orient the plate such that well A1 is in the front left corner.

c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This 
corresponds to chip position 2.

8. Click Chip prep module Deck In/Out again to retract the deck.

5.3  Set up and start the run

WARNING!
Confirm that instrument settings are correct, as shown in the tables below, prior to each run.

1. Select the Run Setup tab in SpectroACQUIRE.

2. In the Experiment Setup section:

a. Under MTP 1, click on the browse button next to Experiment Name and select the 
XML input file created earlier.

b. In the Wells to Process field, select Automatic.

c. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in 
the Experiment Name and Wells to Process fields for MTP 2.

d. Enter the settings as shown in Table 5.1.

Table 5.1   Experiment Setup Settings

3. In the Analyzer Setup section:

a. Select Tools > Load Parameters on the SpectroACQUIRE toolbar, then select the 
appropriate parameter file based on the SpectroCHIP type. Acquisition 
parameters will automatically populate. 

SpectroCHIP CPM-384

Use Autotune Selected

Start Dispense Condition Default (350)

Resin Volume 10

Sample Volume n/a
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b. Make sure all settings in this section are as shown in Table 5.2.

Table 5.2   Analyzer Setup Settings

4. In the Chip Prep Module Setup section:

a. Check the Normal Operation box.

b. Check MTP Barcodes Required, if desired.

c. Select iPLEX in the Chemistry drop-down menu.

5. In the Temperature Control section:

a. If the MTP and calibrant will not be removed from the instrument shortly after the 
run is completed, select the MTP Cool box, and check the Auto box. 

b. Check the Chip Heat box and enter 30 in the Setpoint field.

6. If desired, enter your email and check the When Chip prep module is finished and 
When MA4 is finished boxes to receive email notifications.

7. Click Start Chip prep module to start the run.

5.4  Remove plates, calibrant, and SpectroCHIP Arrays when run is complete

1. Once the run is completed, click Chip prep module Deck In/Out to move the deck out 
and remove the MTPs and calibrant vial. Store remaining calibrant refrigerated or frozen 
for future use.

2. Click Remove Old Chips from MA4 in the Run Setup tab. The instrument will move 
the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed 
chips position on the Chip Prep Module deck, and then extend the deck so you may 
remove the SpectroCHIP Arrays from the completed chips position.

SpectroCHIP CPM-384

Parameter file name iPLEX_CPM.par

Shots (n) 30

Maximum acquisitions 9

Minimum good spectra 5

Maximum good spectra 5

Turn Off HV After Analysis Selected

Analyze Calibrant Pads Selected

Filter Saturated Shots Selected

Chip Type SpectroCHIP CPM-384
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Chapter 6

Data Acquisition on the MassARRAY
Analyzer 4 and Nanodispenser RS1000,

96- or 384-format

6.1  Desalt the analyte

1. Centrifuge the reaction plate at 3200 x g for 1 minute.

2. Spoon 3 scoops of Clean Resin on a clean, dry dimple plate (96/15 mg plate or 384/6 
mg plate as appropriate).

3. Spread out the Clean Resin on the dimple plate using the scraper, making sure the 
resin settles evenly into all wells.

4. Let resin plate dry for 10 minutes at room temperature.

5. Seal the plate and centrifuge at 3200 x g for 1 minute.

6. To add dried Clean Resin to each well:

a. Gently invert the sample plate on top of the dimple plate, making sure that the 
plate wells are aligned over the resin samples.

b. Keep the sample and dimple plates pressed together, and invert both plates so 
that the dimple plate is on top of the sample plate.

c. Gently tap the dimple plate and let the resin fall into the sample wells.

d. Remove dimple plate.

7. Seal the plate and rotate for at least 15 minutes. The rotator must rotate the microplate 
360° around its long axis.

6.2  Prepare the Nanodispenser RS1000

1. Turn on the Nanodispenser RS1000 and log in.

2. If this is the first run of the day, complete the daily maintenance procedures.

a. Perform daily pin maintenance by soaking the pins in 100% ethanol for 30 
minutes.

b. Replace 100% ethanol with 50% ethanol prior to beginning dispensing run.

3. Check tank status.

a. Tap STATUS button at top of Main Menu screen.

b. Tap Page 2 tab.

c. Check status of the supply and waste tanks. Add supply tank water and drain 
waste tank if indicated.

6.3  Set up the dispensing run

1. Load a method file.

a. From the Main Menu, tap TRANSFER.

b. Tap METHODS.
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c. Tap OPEN.

d. Tap 96 MTP to 96 SpectroCHIP Array or 384 MTP to 384 SpectroCHIP Array, 
as appropriate.

2. Select setup parameters on the Method screen.

a. Tap to select the positions on the SCOUT plate that will contain SpectroCHIP 
Arrays.

b. Select the Enable checkbox under Sample Tracking to enable sample tracking, if 
desired.

c. Select the Enable checkbox under Auto tuning.

d. Enter 12 in the Target Volume field.

e. Select the Enable checkbox under Volume Check.

f. Enter 8 in the Lower Limit box.

g. Enter 20 in the Upper Limit box.

3. Tap the cleaning tab on the Method screen and verify that all cleaning steps are 
check marked in the Cleaning Setup box.

4. Tap the aspirate/dispense tab on the Method screen.

a. Under dispense settings, enter 100 for the dispense speed.

b. Under calibrant, enter 100 for the dispense speed.

c. Under operation, select analyte & calibrant.

6.4  Set up the instrument deck

1. Fill the calibrant reservoir.

a. Allow the calibrant to equilibrate to room temperature for 5 minutes (if 
refrigerated) or 10 minutes (if frozen).

b. Tap the PARK button.

c. Open the main door.

d. Fill the calibrant reservoir with 60 μL calibrant using a pipette.

2. Load the microtiter plates.

a. Open the main door.

b. If using a non-skirted 96-well MTP, place the MTP on the 96-well fully skirted plate 
base.

c. Place the first MTP on plate holder 1 (on the left), orienting it so that well A1 is 
located at the front left corner of the plate holder.

d. If there is a second MTP, place it on plate holder 2 (on the right).

3. Load the SpectroCHIP Arrays.

a. Remove the SCOUT plate from the deck, if it is not already removed.

b. Orient the SCOUT plate so that the bevelled corners are at the right.

c. Insert the SpectroCHIP Arrays into the SCOUT plate positions that were specified 
earlier. Orient the SpectroCHIP Arrays so that the Agena Bioscience logo is at the 
front. Make sure each SpectroCHIP Array is seated flat in its position and flush 
with the front-left corner.

d. Place the SCOUT plate back onto the deck, placing the left edge of the SCOUT 
plate down first, against the alignment post, and then pressing down the right 
edge until the spring-loaded positioners engage firmly against the plate.
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4. Close the main door.

5. Tap HOME.

6.5  Start the nanodispensing run

1. Tap BACK on the Method screen.

2. Tap Apply.

3. Tap the run button.

4. Tap OK in the rinse station preparation window.

5. If the rinse station operates correctly (if water flows out of the rinse station chimneys), 
tap YES.

6.6  Remove plates, calibrant, and SpectroCHIP Arrays when run is complete

1. Tap the BACK button on the Transfer screen.

2. Tap PARK.

3. Open the main door.

4. Pull the spring-loaded positioners away from the SCOUT plate and lift it off the deck.

5. Remove the SpectroCHIP Arrays using tweezers and place them in the SpectroCHIP 
Array carriers for the MassARRAY Analyzer.

6. Remove the MTPs from the plate holders and discard or store for future use.

7. Close the main door.

8. Tap HOME.

9. Open the main door.

10. Pipette out any remaining calibrant and return it to the calibrant storage container for 
future use. Store at -20ºC.

11. Close the main door.

12. Tap HOME.

6.7  Set up the acquisition run on the MassARRAY Analyzer 4

1. Double-click the Analyzer 4 instrument icon to launch the software.

2. Click the Probe Sample In/Out button in the SpectroACQUIRE toolbar to move the 
chip holder to the load position.

3. Open the sample chamber lid and remove the chip holder.

4. Remove any previously run SpectroCHIP Arrays from the chip holder.

5. Orient the child holder so that the bevelled corner is at the top right.

6. Open a new SpectroCHIP Array pouch and place the SpectroCHIP Array into the chip 
holder in position 1 (on the left), such that the Agena logo and barcode are at the 
bottom. 
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7. If running two SpectroCHIP Arrays, insert the second chip in the chip holder in 
position 2 (on the right). If only running one SpectroCHIP Array, place a previously run 
SpectroCHIP Array in position 2.

8. Place the loaded chip holder in the Analyzer 4 sample chamber. Firmly press down 
on the sample chamber lid.

9. Click Probe Sample In/Out.

6.8  Create an input file

1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry. 

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 96 to 96 or Nanodispenser 384 to 384 as the dispenser 
method. 

8. Enter an experiment name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the 
second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set 
up the Analyzer run.

6.9  Set up and start the Analyzer run

1. Select the Run Setup tab in SpectroACQUIRE.

2. Next to Chip 1, click on the browse button and select the XML input file created earlier.

3. Repeat for Chip 2 if acquiring data from a second SpectroCHIP Array.

4. Select Tools > Load Parameters on the SpectroACQUIRE toolbar and select the 
iPLEX.par parameter file, then click Open.

5. Ensure that the acquisition parameters as are shown in Table 6.1.

Table 6.1   Acquisition Parameters
Parameter Setting

Shots (n) 20

Maximum acquisitions 9

Minimum good spectra 5

Maximum good spectra 5



Chapter 6  Data Acquisition on the MassARRAY Analyzer 4 and Nanodispenser RS1000, 96- or 384-format 33

IFU-CUS-001 R02SARS-CoV-2 Panel Instructions for Use
Pending FDA Review.

WARNING!
Confirm acquisition parameter settings prior to each run.

6. Select the Filter Saturated Shots checkbox.

7. Select the Use Calibration Wells and Auto Teach Geometry checkboxes.

8. Select SpectroCHIP-96 or SpectroCHIP-384 in the Chip Type menu.

9. Select the Turn off HV After Last chip is complete checkbox.

10. Click Barcode Report in the Automatic Run Setup tab.

11. Check that the status of each SpectroCHIP Array is Found.

12. Click Close.

13. If any errors were found, correct them, and perform another barcode report.

14. Select the Automatic Run tab.

15. Click the Start Autorun button.

6.10  Remove SpectroCHIP Arrays when run is complete

1. Select the Automatic Run tab.

2. Press the manual stage control button on the front of the Analyzer 4 to extend the 
target.

3. Open the sample chamber lid and take out the chip holder. Remove the SpectroCHIP 
Arrays from the chip holder and place the chip holder back into the chip carrier.

4. Press the manual stage control button to retract the chip carrier.
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Chapter 7

Analysis and Results

7.1  Analyze the data

1. Open MassARRAY Typer Analyzer and in the Project Explorer pane double click on the 
SpectroCHIP Arrays of interest. The SpectroCHIP Arrays will be added to the Chip List.

2. Load the SpectroCHIP Arrays by checking the box next to the SpectroCHIP Array 
names in the Chip List.

3. Select File > Reports > SC2 Report-v1 in the MassARRAY Typer Analyzer menu bar.

When the report is complete, the SC2ReportDetails.csv will automatically open, and the 
results will be made available in a date- and time-stamped folder in the Typer/bin/
TyperReports/SC2 Report folder.

7.2  Interpretation of the results

Interpretation of the results is performed by the Agena Bioscience SC2 Report software.

Quality control and 
validity of results

One negative control and one positive control are processed with each run.

Validation of results is performed automatically by the Agena Bioscience SC2 Report 
software based on performance of the positive and negative controls.

Table 7.1   Result Interpretation

SARS-CoV-2 Targets MS2 QC Status Result Recommended 
Action

≥ 2 SARS-CoV-2 targets detected Detected PASS Detected Report results

≥ 2 SARS-CoV-2 targets detected NotDetected WARNING Detected Report results

< 2 SARS-CoV-2 targets detected Detected PASS NotDetected Report results

< 2 SARS-CoV-2 targets detected NotDetected FAIL Invalid Repeat test
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Chapter 8

Performance Characteristics

8.1  Limit of detection (LoD)

This LoD study established the lowest SARS-CoV-2 viral concentration (genomic copy 
equivalents or GCE) that can be detected by the Agena Bioscience SARS-CoV-2 Panel at 
least 95% of the time. Bronchoalveolar lavage (BAL) clinical samples were collected 
before October 2019. More recent clinical samples from nasopharyngeal (NP) swabs 
were collected, pooled, and tested negative using Hologic® Panther Fusion® SARS-CoV-2 
Assay and confirmed using Agena Bioscience SARS-CoV-2 Panel. 

Samples were spiked with synthetic SARS-CoV-2 RNA (Twist Bioscience, #102019) at 
several concentrations and processed through the Agena Bioscience SARS-CoV-2 Panel 
workflow on the MassARRAY System with Chip Prep Module 96. A three-phase approach 
was used to determine the LoD for each sample type. Phases I and II determined the LoD 
(Table 8.1 and Table 8.2), which was confirmed in Phase III by testing 20 replicates (Table 
8.3).

Table 8.1   LoD Determination Study Results (BAL Samples)

Table 8.2   LoD Determination Study Results (NP Samples)

Table 8.3   LoD Confirmation Study Results

Effective Concentration
(copy/μL)

# Positive/Total 
Replicates % Positive

0 0/3 0

0.00625 0/3 0

0.0125 0/3 0

0.025 1/3 33

0.05 2/3 67

0.1 2/3 67

0.2 3/3 100

0.4 3/3 100

Effective Concentration
(copy/μL)

# Positive/Total 
Replicates % Positive

0 0/3 0

0.00625 1/3 33

0.0125 1/3 33

0.025 2/3 67

0.05 1/3 33

0.1 1/3 33

0.2 2/3 67

0.4 3/3 100

Effective 
Concentration

(copy/μL)

# Positive/
Total 

Replicates
% Positive

Effective 
Concentration

(copy/μL)

# Positive/
Total 

Replicates
% Positive

BAL Samples NP Samples

0.3 20/20 100 0.4 19/20 95
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8.2  Inclusivity

Homology verification was carried out using a consensus sequence from 2,661 complete 
SARS-CoV-2 genomes (NCBI; May 20, 2020). A multiple sequence alignment (MAFFT 
version 7) was carried out to generate the consensus sequence, which was used to 
determine conserved regions of the virus. Subsequently all assay components (two PCR 
primers and a probe) were aligned to the conserved regions. All assay components 
exhibit 100% sequence homology to conserved SARS-CoV-2 regions except for the 
forward PCR primer for the SC2_N2 assay. According to the sequence data as of May 20, 
2020, 8% of the SARS-CoV-2 sequences have a three-nucleotide mismatch with the first 
three 5’ end nucleotides of the SC2_N2 forward PCR primer (22 nucleotide length). This 
results in the 86% PCR primer homology for the 8% of SARS-CoV-2 population and the 
98.9% weighted homology. The mismatch is located at the 5’ end of the PCR primer and 
does not affect the test performance.

8.3  Cross-reactivity

In silico cross-reactivity analysis was carried out with NCBI nucleotide BLAST against a 
list of FDA-recommended cross-reactivity organisms (Table 8.4). The analysis was 
performed using the May 22, 2020 version of the microbial NCBI database. Components 
of three assays exhibit greater than 80% homology to a listed evaluation specie. 

•   SC2_N1 assay. Two SC2_N1 assay components exhibit >80% in silico homology to a 
listed organism (SARS-coronavirus). However, the cross-reactive assay 
components are not the PCR primers, but a combination of one PCR primer and the 
probe. The forward primer showed 82% homology while the reverse primer 
showed 75% homology and the probe showed 94% homology to SARS-
coronavirus. The SC2_N1 reverse primer shows low homology; therefore the risk of 
non-specific PCR amplification of SARS-coronavirus is low. This is confirmed by the 
NCBI Primer BLAST. Furthermore, reverse transcription of RNA into DNA requires 
high reverse PCR primer homology. Low homology of the reverse primer further 
reduces non-specific amplification.

•   SC2_N2 assay. One SC2_N2 assay component exhibits >80% homology to a listed 
organism (SARS-coronavirus). The forward primer showed 91% homology while the 
reverse primer showed 68% homology and the probe showed 55% homology to 
SARS-coronavirus. The SC2_N2 reverse primer and probe show low homology; 
therefore the risk of non-specific PCR amplification and probe extension of SARS-
coronavirus is low. This is confirmed by the NCBI Primer BLAST. Furthermore, 
reverse transcription of RNA into DNA requires high reverse PCR primer homology. 
Low homology of the reverse primer further reduces non-specific amplification.

•   SC2_ORF1ab assay. One SC2_ORF1ab assay component exhibits >80% homology 
to a listed organism (SARS-coronavirus). The probe showed 88% homology while 
the forward primer showed 76% and the reverse primer showed 37% homology to 
SARS-coronavirus. The SC2_ORF1ab forward and reverse primers show low 
homology; therefore the risk of non-specific PCR amplification of SARS-coronavirus 
is low. This is confirmed by the NCBI Primer BLAST. Furthermore, reverse 
transcription of RNA into DNA requires high reverse PCR primer homology. Low 
homology of the reverse primer further reduces non-specific amplification.
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Table 8.4   Organism List Used for BLAST Similarity Evaluation

8.4  Clinical evaluation

A clinical evaluation study was performed to evaluate the performance of the Agena 
Bioscience SARS-CoV-2 Panel, using clinical samples from nasopharyngeal (NP) and 
contrived bronchoalveolar lavage (BAL) samples. The BAL clinical samples were 
collected before October 2019 and NP clinical samples were obtained from Boca 
Biolistics (#C0040-0001). 

Bronchoalveolar 
lavage samples

A total of 30 contrived positive samples were tested as well as 30 negative samples. 
Samples were contrived by spiking known concentrations of synthetic SARS-CoV-2 RNA 
(Twist Bioscience, #102019). The samples were randomized, blinded, and tested with the 
Agena Bioscience SARS-CoV-2 Panel. Twenty of the samples were spiked at 0.6 copies/
μL, five at 1.2 copies/μL, and five at 2.4 copies/μL. Results are shown in Table 8.5.

High priority pathogens from the 
same genetic family

High priority organisms likely in 
circulating areas

Human coronavirus 229E Adenovirus (e.g., C1 Ad. 71)

Human coronavirus OC43 Human Metapneumovirus (hMPV)

Human coronavirus HKU1 Parainfluenza virus 1-4

Human coronavirus NL63 Influenza A & B

SARS-coronavirus Enterovirus (e.g., EV68)

MERS-coronavirus Respiratory syncytial virus 

Rhinovirus

Chlamydia pneumoniae

Haemophilus influenzae

Legionella pneumophila

Mycobacterium tuberculosis

Streptococcus pneumoniae

Streptococcus pyogenes

Bordetella pertussis

Mycoplasma pneumoniae

Pneumocystis jirovecii (PJP)

Pooled human nasal wash – to represent 
diverse microbial flora in the human respiratory 
tract

Candida albicans

Pseudomonas aeruginosa

Staphylococcus epidermis

Staphylococcus salivarius
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Table 8.5   Clinical Evaluation Study Summary (BAL Samples)

*The RNA extraction for the false negative result for the 2.4 copies/μL sample was retested at 2-fold 
and 4-fold dilution of the RNA extraction and both results were “Detected.” This is indicative of RT-
PCR inhibition due to insufficient alcohol removal from last wash step of RNA extraction.

Nasopharyngeal 
samples

A total of 30 individual positive clinical NP samples and 60 negative clinical NP samples 
characterized by the Hologic Panther Fusion SARS-CoV-2 Assay (Comparator Test) were 
tested. The samples were randomized, blinded, and tested with the Agena Bioscience 
SARS-CoV-2 Panel. Three samples were invalid due to RNA extraction and reaction setup 
control not being detected. 

The positive percent agreement (PPA) was 97% and the negative percent agreement 
(NPA) was 72% as shown in Table 8.6. Discordant analysis for the 16 false positive and 1 
false negative was performed with the Bio-Rad SARS-CoV-2 ddPCR Kit (#12008202/
1864021) and these results are show in Table 8.7. The Agena Bioscience SARS-CoV-2 
Panel had a 94% agreement with Bio-Rad SARS-CoV-2 ddPCR test, resolving 15 of 16 
false positives and 1 of 1 false negatives, as shown in Table 8.8.

Table 8.6   PPA and NPA Results of the Agena Bioscience SARS-CoV-2 Panel Against 
Comparator Test (NP Samples)

Effective 
Concentration

(copy/μL)

# Positive/Total 
Replicates % Positive

0 copies/μL 0/30 0%

0.6 copies/μL 20/20 100%

1.2 copies/μL 5/5 100%

2.4 copies/μL 4/5* 80%

Comparator Test

Detected Not Detected

Agena Bioscience 
SARS-CoV-2 Panel

Detected 29 16

Not Detected 1 41

Total 30 57

PPA: 97%; NPA: 72%
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Table 8.7   Description of Excluded and Discordant Cases (NP Samples)

Note: Samples M93, M96 through M103, M107 through M111, M113 through M116, M118, and M120 are 
Not Detected by all three tests.

Table 8.8   Summary of Test vs. Comparator vs. Adjudication (NP Samples)

Sample ID Agena Bioscience 
SARS-CoV-2 Test

Comparator Test 
(Hologic Panther 
Fusion EUA Test)

Adjudication Test 
(Bio-Rad SARS-CoV-

2 Test)

M15 Not Detected Detected Not Detected

M34 Detected Not Detected Detected

M35 Detected Not Detected Detected

M36 Detected Not Detected Detected

M37 Detected Not Detected Detected

M40 Detected Not Detected Detected

M43 Detected Not Detected Detected

M45 Detected Not Detected Detected

M48 Detected Not Detected Detected

M50 Detected Not Detected Detected

M51 Detected Not Detected Detected

M52 Detected Not Detected Not Detected

M58 Detected Not Detected Detected

M59 Detected Not Detected Detected

M91 Invalid Not Detected N/A

M92 Detected Not Detected Detected

M94 Invalid Not Detected N/A

M95 Detected Not Detected Detected

M104 Invalid Not Detected N/A

M105 Detected Not Detected Detected

M106 Detected Not Detected Detected

M112 Detected Not Detected Detected

M117 Detected Not Detected Detected

M119 Detected Not Detected Detected

Test Comparator Adjudication

Agena Bioscience SARS-
CoV-2 Panel 
(0.4 cps/μL)

Hologic Panther Fusion 
SARS-CoV-2 Assay
(0.01 TCID50/mL)

Total Subjects
Bio-Rad SARS-CoV-2 ddPCR Kit

(0.6 cps/μL)

Detected Not Detected Not Tested

Detected Detected 29 N/A N/A 29

Detected Not Detected 16 15 1 N/A

Not Detected Detected 1 0 1 N/A

Not Detected Not Detected 41 4 20 17

Invalid Not Detected 3 N/A N/A 3

Total 90 N/A N/A N/A
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Chapter 9

Support

9.1  Customer support

Please contact your local Agena Bioscience office for customer support.

CORPORATE HEADQUARTERS & NORTH AMERICA 
Agena Bioscience, Inc.
4755 Eastgate Mall
San Diego, CA 92121 USA
Phone: 1-858-882-2800
Fax:  1-858-882-2727
Help Desk:  1-877-4-GENOME or (+1) 858-882-9300
E-mail:  helpdesk@AgenaBio.com 

EUROPE 
Agena Bioscience GmbH
Gasstrasse 18, House 5
22761, Hamburg Germany
Phone:  (+49) 40-899676-0
Fax:  (+49) 40-899676-10
Email:  support-europe@AgenaBio.com

AUSTRALIA and NEW ZEALAND
Agena Bioscience, Inc.
Ground Floor, 27 Jeays Street
Bowen Hills, QLD  4006 Australia
Phone:  (+61) 7 3088 1600
Fax:  (+61) 7 3088 1614
Email:  support-anz@AgenaBio.com

CHINA and ASIA PACIFIC
Agena Bioscience (Shanghai) Co., Ltd.
Room 1609-1613, Building A
Fenglin International Center
No. 380 Fenglin Road, Xuhui District
Shanghai 200032 PR China
Phone:  (+86) 21 6427 0566
Fax:  (+86) 21 6427 0511
Email: support-china@AgenaBio.com
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IFU-CUS-001 R02SARS-CoV-2 Panel Instructions for Use
Pending FDA Review.

9.2  Related documentation

Table 9.1   Related User Documentation
Document Document #

MassARRAY System with Chip Prep Module 96 User Guide USG-CUS-069

MassARRAY System with Chip Prep Module 384 User Guide USG-CUS-097

MassARRAY Analyzer 4 User Guide USG-CUS-034

MassARRAY Nanodispenser RS1000 v2.1 User Guide USG-CUS-059

MassARRAY Typer User Guide USG-CUS-027
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